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LI File Home Insert Draw Page Layout Formulas Data Open in Desktop App Q Search L~ 3 | Econversation | | * | | Close
B v. e < i Jn v B v av Av o ab, General J o @ Sy g Oy .-
Chat | | »
ves  D1577 - f
w
Teams A B (= D E 7 G H | ] K L M N (o] P Q R
13712 u u u U u -
. 1573 |- - -
7 (4] 0
e ] 1574 0 0 | Find X
ki 0 O | find what
1576 ABREU I
Calls 1577 o] 1]
1578 0 arian Abrev 0
.. 1579 0 arian Abret o | » Search Options
1580 0 arian Abre. 0
1581 0 drian Abre. 0 Find Next Find All Replace
1582 0 arian Abret 0 .
1583 0 arian Abred [} 0 [
1584 0 arian Abreu 0 0 0
1585 0 irian Abret 0 0 0
1586 0 arian Abret 0 0 0 .
Apps — - R - - - - 5

= LTV Avreu | |

& SEARCH FOR CONTACT TRACER’S LAST NAME
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Contact st Templatexdsx — _

Ejo Your status message is showing in chat and channels when people message or @mention you, Change status. X
A File Home  Insert ~ Draw  Page layout  Formulas  Data v Open in Desktop App Q@ Search &~ 3 Econversation - | Close
S Dy Blv ¥ |calibri v11 v B Hv v Av v Ev b B General vl R OB Xy ey Ov e
Chat Bt — v
A1577 v &
A B D E F G H | ) K L M N (¢] P Q R
. 1565 repo-| o 0 0 0 B
1566 | o 0 0 0
Calendar 4o 0 0 0 o
Q; 1568 0 0 0 0
= 1569 0 o 0 0 0
1570 0 0 0 4] 0
1571 0 0 0 0 0
1572 0 0 0 0 0
1573 0 0 0 0 0
1574 0 0 0 0 0
1575 ] 0 0 0 0
1576
1577 ! 0 arian Abret 0 0
1578 ] arian Abred o 0 0 0
Apps 1579 0 arian Abrel 0 0 0 0 - -
‘
@ H = ™ UNsorTED [

TOP CELLA &

e — _

Q.Io Your status message is showing in chat and channels when people message or @mention you. Change status, X
b=l File Home Insert Draw Page Layout Formulas Data v Open in Desktop App Q Ssearch &~ (1 Elconversation | Close
@ D~ [v ¥ |calibi vl v B v v Av o 3, [E v |General v @ O® T ospe O e .
Chat
A1577 ¥ fr =Abreu2lA2:K75
A B c D E F G H 1 J K L M N o P Q R
1608 0 arian Abrev 0 0 0 0 -
1609 0 0 0 0
Candsr | 1610 BT Insert 0 0 0 0
1611 1] [} ) 0
Delete
1612 Eﬁ 0 4] 4] 0
s 1613 Rename.. 0 0 0 0
1614 o] 0 o 0
w1615 Reorder. 0 0 0 0
1616 Duplicate 0 0 0 0
1617 0 0 0 0
1618 Tab Color > 0 0 0 0
1619 0 0 0 0
1620 Hide 0 0 0 0
B 1621 Unhide... 0 0 4] 0
o 1622 0 0 0 0 -
B « ES show Changes L
— — —
@ ¢« > = o g el [
i Calculation Mode: Automatic  Workbook Statistics v — 100% +

UNSORTED TAB AND SELECT FROM MENU
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MAINTAINING MASTER PAGE
IF MASTER PAGE IS SHOWING A BUNCH OF ZEROS OR DATED INFORMATION, FILTERS NEED REFRESH

S — A _

Q Your status message is shy | - pnd channels when people message or @mention you. Change status. X

Activity

File Home Insert Draw Page Layout sktop App Q Ssearch &~ @ 3 Econversation - | Close

D ovpy e o e NECAY o Sv o Bvomes o % 8 T wv Ov o
2 =
H1512 v fx
A B C D = F G H | J K

ROCK PCG  6/3/21 CLOSED No Symptoms - Minor
1501 PUT PCG 6/5/21 George Fischer Middle < CLOSED Minor
1502 ROCKTVL  6/5/21 0 CLOSED Left voicemail
% 1503 PUTPCG 6/5/21 SMS CLOSED Agreed to SMS & Email
B 1504 ROCKPCG  6/6/21 Eldorado Elementary Sc SMS CLOSED Minor (Spanish-speakin
1505 ROCK PCG  6/6/21 SMS CLOSED Initial Interview Comple
e 1506 ROCKPCG  6/6/21 INTERVIEW CLOSED "Registered in Error" Pa
1507 ROCK PCG ~ 6/6/21 CALL CLOSED Invalid Phone Number
1508 ROCK PCG  6/6/21 INTERVIEW CLOSED Tranferred to CT Bonnie
1509 ROCKPCG  6/6/21 SMS CLOSED Agreed to SMS & Email
1510 ROCK PCG  6/6/21 0 CLOSED Invalid Phone Number -
1511 ROCKPCG  6/6/21 No SMS OPEN  Will quarantine-Minor ¢
1512 | ROCKPCG  6/6/21 SMs  OPEN  Will quarantine-Minor
1513 PUT PCG 6/7/21 0 CLOSED Transferred to Putnam i~

Apps
0

-
>E-l — — R :+

ON TOP HEADER OF MASTER PAGE

contact st Template.xtex — _

0 Your status message is showing in chat and channels when people message or @mention you. Change status, X
R File Home Insert  Draw age Layout | v Openin Desktop App & Search &~ @ O Econversation Close
c@ v Blv @ |Ca“bn Formlas S 4y Av e = g v | General P T R SRV TV o R .
H1512 v S
Review D E F G H 1 J K
View
ROCKPCG = 6/3/21 SMS CLOSED No Symptoms - Minor =
Calendar 1501 |4 PUT PCG 6/5/21 George Fischer Middle ¢ SMS CLOSED Minor
1502 |« ROCK TVL 6/5/21 1] CLOSED Left voicemail
Q) 1503 |1 PUT PCG 6/5/21 SMS CLOSED Agreed to SMS & Email
Gl 1504 ) ROCKPCG  6/6/21 Eldorado ElementarySc  SMS  CLOSED Minar (Spanish-speakin
1505 ) ROCKPCG | 6/6/21 SMS CLOSED Initial Interview Comple
o 1506 |t ROCKPCG  6/6/21 INTERVIEW CLOSED "Registered in Error” Pa
1507 |I ROCKPCG  6/6/21 CALL CLOSED Invalid Phone Number 1
1508 | ROCKPCG  6/6/21 INTERVIEW CLOSED Tranferred to CT Bonnie
1509 |I ROCKPCG  6/6/21 SMS CLOSED Agreed to SMS & Email
1510 || ROCKPCG  6/6/21 0 CLOSED Invalid Phone Number -
1511 ) ROCKPCG = 6/6/21 No SMS OPEN  Will guarantine-Minor &
1512 |2 ROCKPCG = 6/6/21 |No L SMS OPEN  Will guarantine-Minor
1513 |) PUT PCG 6/7/21 1] CLOSED Transferred to Putnam ¢ =

b

@ - > =l - S ————
DATA FROM MENU

contact Ht TempRteEx — _

Q Your status message is showing in chat and channels when people message or @mention you. Change status. X
L File Home Insert Draw  Data Open in Desktop App Q Ssearch &~ @ O Bconversation = Close
5] (1552 3l % Y 2 Zf TexttoColumns & Flashfill B} Remove Duplicates % Data Validation =~ 8Hv @B~ o

1500 ROCKPCG  6/3/21 SMS CLOSED No Symptoms - Minor *
Calendar 1501 PUT PCG 6/5/21 George Fischer Middle € SMS CLOSED  Minor

REAPPLY ICON
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MASTER PAGE EXPLAINED

SORT FUNCTION

SORT FUNCTION IS SORTING DATA THRU A SPECIFIC COLUMN, IN ASCENDING OR DESCENDING ORDER

Jx | =SORT(UNSORTEDI!A2:K2400,7,1,FALSE)

= SORT(TABLEOFDATA, coLuMNNUWER, [IRBRIMSGENBING, FALSE TO SORT BY ROW)

% COLUMNA=1,B=2,C=3,ETC; INTHIS CASE IT'S 7 FOR QED, OR COLUMN G

«% OPTIONS ARE 1 TO SORT BY ASCENDING ORDER OR -1 TO SORT BY DESCENDING ORDER

16



FILTER FUNCTIONS

HOW TO APPLY FILTERS IF GONE/DELETED

Contact List Template.xlsx

Activity

H1512 R

Q search

A _

File Home Insert Draw

@ v Elv ¥ |Calibri v v
Chat

Page Layout

L pnd channels when people message or @mention you. Change status. x
Q Ssearch &~ @ o] [l conversation Close

@8 T e oy o

Your status message is shy

sktop App

v Av o =Ev 2

1500 ROCK PCG  6/3/21 CLOSED No Symptoms - Minor
1501 PUT PCG 6/5/21 George Fischer Middle < CLOSED Minor
1502 ROCK TVL 6/5/21 0 CLOSED Left voicemail
% 1503 PUTPCG 6/5/21 SMS CLOSED Agreed to SMS & Email
s 1504 ROCKPCG  6/6/21 Eldorado ElementaryScl  SMS  CLOSED Minor (Spanish-speakin
1505 ROCK PCG  6/6/21 SMS CLOSED Initial Interview Comple
e 1506 ROCKPCG  6/6/21 INTERVIEW CLOSED "Registered in Error" Pa
1507 ROCK PCG ~ 6/6/21 CALL CLOSED Invalid Phone Number
1508 ROCK PCG  6/6/21 INTERVIEW CLOSED Tranferred to CT Bonnie
1509 ROCKPCG  6/6/21 SMS CLOSED Agreed to SMS & Email
1510 ROCK PCG  6/6/21 0 CLOSED Invalid Phone Number -
1511 ROCKPCG  6/6/21 No SMS OPEN  Will quarantine-Minor ¢
1512 | ROCKPCG  6/6/21 SMs  OPEN  Will quarantine-Minor
o 1513 3 PUT PCG 6/7/21 0 CLOSED Transferred to Putnam i~
‘ v
= — — =

ON TOP HEADER OF MASTER PAGE

Contact List Template.xlsx Q_ Search

File Home Insert Draw

Your status message is showing in chat and channels when people message or @mention you. Change status, X

age Layout | v Open in Desktop App Q  Search V% @ 1 Fconversation Close

cﬁa v Blv @ |Calibn Formulas = dy o A e 2, v | General P T R SRV TV o R .
H1512 v S
| ‘ﬂ Review
Teams D H F G H I J K
View
1500 ROCKPCG  6/3/21 SMS CLOSED No Symptoms - Minor | *
Calendar | 1501 PUT PCG 6/5/21 George Fischer Middle £ SMS CLOSED Minor
1502 ROCKTVL | 6/5/21 0 CLOSED Left voicemail
QD 1503 PUT PCG 6/5/21 SMS CLOSED Agreed to SMS & Email
Gl 1504 ROCKPCG  6/6/21 Eldorado ElementarySc  SMS  CLOSED Minar (Spanish-speakin
1505 ROCKPCG  6/6/21 SMS CLOSED Initial Interview Comple
o 1506 ROCKPCG = 6/6/21 INTERVIEW CLOSED "Registered in Error" Pa
1507 ROCKPCG  6/6/21 CALL CLOSED Invalid Phone Number 1
1508 ROCKPCG  6/6/21 INTERVIEW CLOSED Tranferred to CT Bonnie
1509 ROCKPCG = 6/6/21 SMS CLOSED Agreed to SMS & Email
1510 ROCKPCG  6/6/21 0 CLOSED Invalid Phone Number -
1511 ROCKPCG  6/6/21 No SMS OPEN  Will quarantine-Minor ¢
1512| ROCKPCG = 6/6/21 No I sms OPEN  Will quarantine-Minor
Apps 1513 PUT PCG 6/7/21 1] CLOSED Transferred to Putnam ¢ =
‘ v
o > = - e ———

DATA FROM MENU
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Contact List Templat

— _

Q Your status message is showing in chat and channels when people message or @mention you. Change status X
Aty File Home Insert Draw  Data Open in Desktop App Q Search Vg @ O Econversation - Close
g l?: A El %l ? & Remove Duplicates %‘@/ Data Validation afv @fv -
- Al v  fr First Name
A C D E F G H | J K
1
20 0 0 Darian Abreu 0 1/0/00 0 0 =
gar 30 0 o Darian Abreu 0 1/0/00 0 0
4 0 0 0 Darian Abreu 0 1/0/00 0 0
50 0 [1] Darian Abreu 0 1/0/00 0 0
“s 5 0 0 o Darian Abreu 0 1/0/00 0 0
7 0 0 0 Darian Abreu 0 1/0/00 0 0
8 0 0 0 Darian Abreu 0 1/0/00 0 0
9 0 0 0 Darian Abreu 0 1/0/00 0 0
10 0 0 0 Darian Abreu 0 1/0/00 0 0
1 0 0 0 Darian Abreu 0 1/0/00 ] 0
12 0 0 0 Darian Abreu 0 1/0/00 0 0
13 0 0 0 Darian Abreu 0 1/0/00 0 0
m 14 0 0 [1] Darian Abreu 0 1/0/00 0 0
o 15 0' 0 0 Darian Abreu 0 1/0/00 0 0 . hd
T ] I

Contact Hst Templateaisx — _

Q Your status message is showing in chat and channels when people message or @mention you. Change status. X

L2l File Home  Insert  Draw Open in Desktop App Q Search V4 @ O Econversation -+ Close

O 5

Chat

EE Text to Columns gﬁ Flash Fill & Remove Duplicates ?é Data Validation af~ éfv

A2 ¥ fr =SORT(UNSORTI

Teams A B C D E F G H I J K
! o 0 Darian Abreu 0 1/0/00 0 0 -
Calendar 3 0 0 0 Darian Abreu 0 1/0/00 0 0
4 0 0 0 Darian Abreu 0 1/0/00 0 0
5 0 0 0 Darian Abreu 0 1/0/00 0 0
“E 65 0 0 0 Darian Abreu 0 1/0/00 0 0
7 0 0 0 Darian Abreu 0 1/0/00 0 0
0 8 0 0 0 Darian Abreu 0 1/0/00 0 0
9 0 0 0 Darian Abreu 0 1/0/00 0 0
10 0 0 0 Darian Abreu 0 1/0/00 0 0
1 0 0 0 Darian Abreu 0 1/0/00 0 0
12 0 0 0 Darian Abreu 0 1/0/00 0 0
13 0 0 0 Darian Abreu 0 1/0/00 0 0
14 0 0 0 Darian Abreu 0 1/0/00 0 0
) 15 0 0 0 Darian Abreu 0 1/0/00 0 0 -
“« »
= - — — =

FILTER ICON FROM TOOLBAR
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Contact Bt Templateaisx — _

Q Your status message is showing in chat and channels when people message or @mention you. Change status, X
Activty File Home Insert  Draw  Data Open in Desktop App Q search g~ © © Bconversation | Close
g |r"s i 4l 2l EE Text to Columns £ Flash Fill rx Remove Duplicates £S5 Data Validation g~ @i+ o
s v
A B c D E F G H 1 J K

1
20 0 0 0 1/0/00 0 0 -
P 3 o 0 o ort Smallest to Largest n o o
4 0 0 0 Sort Largest to Smallest Equals... 0 o]
5 |o 0 o 0 0
Calls 5 |o 0 0 [Custom Sort 0 0
70 Q 0 : 0 0
@ Sheet View >
o s 0 0 0 Greater Than.. 0 0
9 0 0 0 Less Than... 0 0
10 o0 0 0 1/0/00 0 0
1 0 0 0 Between 1/0/00 0 0
12 o [1] 1] 1/0/00 0 0
Filter...
13 o 0 0 et Top 10.. 1/0/00 0 0
14 0 0 0 Darian Abreu Above Average 1/0/00 0 1]
s 150 0 0 Darian Abreu 1/0/00 0 0 -
4 Below Average »
— | — — — —

~
1]
=

UL Pl - ——

ARROW FROM CONTACT ID COLUMN, NAVIGATE TO AND GO ON

TO

Contact st Templateisx — _

Q Your status message is showing in chat and channels when people message or @mention you. Change status, X
Activity File Home  Insert  Draw  Data v Open in Desktop App Q search &~ @ O Bconversation - Close
Chat v

Teams A B = D E F G H I K
First Name | - |Last Name | - [ContactiD ||
2 0 0 0 Darian Abreu 0 1/0/00 0 0 .
Calandar S 0 0 Darian Abreu 0 0
4 o 0 0 Darian Abrey | Custom Filter * 0 0
5 |0 0 Darian Abreu | Show items where: Contact ID 0 0
e 6 0 0 0 Darian Abreu 0 0
. . does not equal v 0
0 0 0 Darian Abreu 0 0
o 8 0 0 0 Darian Abreu 0 0
9 0 0 0 Darian Abreu X ﬂ 0 0
10 0 0 0 Darian Abreu A\ T 0 0
1 0 0 0 Darian Abreu 1/0/00 0 0
12 0 0 0 Darian Abreu 1/0/00 a 0
13 0 0 0 Darian Abreu 1/0/00 0 0
14 0 (1] 0 Darian Abreu 1/0/00 0 0
fms 15 0 0 0 Darian Abreu 0 1/0/00 0 0 -
“ »

@ > = [ X [ - - _— F

ZERO AND SELECT OK
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Templatexisx — _

Q Your status message is showing in chat and channels when people message or @mention you. Change status, X
ey File Home Insert Draw  Data v Open in Desktop App Q search &£~ [ ] caual “ Close
— quals...
% FS v ﬂ, ﬁl ? T{'( Tg EE Text to Columns g@ Flash Fill & Remove Duplicates %‘@/ C Before.. "
METR— .
Teams A B C D E [ G H Between...
ROCK PCG Tomorrow toCTL*
Calendsr  g47 ROCK PCG Mat §
948 ROCK PCG Soft Newest to Oldest 1093 gned t
1136 _ ROCKPCG 1 Yesterday and cl
| _ ROCKPCG 1 CUstom Sort edfro
1245 ROCKPCG  1/20/0 @ Sheet View > Next Week
o 1246 ROCKPCG  1/30/i Thi "
1247 ROCK PCG ' is Wee
1248 PUT PCG Last Week 8
1249 PUT PCG > 8
1250 PUT PC Filter Next Month 8
1251 ROCK PCG | - This Monh 1/21
B PUTPCG  1/23/21No ¢ This Mon 6
o 1253 PUTPCG  1/23/21 No § Last Month 6 -
‘ v
— — — — —
@ > = |[Master [ +  NextQuarter
ARROW FROM QED COLUMN, NAVIGATE TO AND GO ONTO
Contact LSt Template x(ex — _
Q Your status message is showing in chat and channels when people message or @mention you. Change status. X
LA File Home  Insert  Draw  Data ~ Open in Desktop App Q search Vs 7 B conversation | -+ | Close
Chat v
o
i
Teams A B C D E [ G H | J K
! First Name | - |Last Name | - |contact ID [~ [Primary cT [~ Jremp cr [~ |county | - |a€D |- [cluster [~ |Follow-Up! - |status! - |Notes
946 ROCK PCG  1/0/00 INTERVIEW 0 Perm reassigned to CT | *
Calendar 947 1 INTERVIEW CLOSED 4/15/21 @ 3:06PM at 8
948 Custom Filter X INTERVIEW CLOSED Permanantly assigned t
Q) 1136 't Show items where: QED 0 CLOSED Released from Q and ck
Calls
1137 |[ : 0 CLOSED Closed and released fro
1245 |y is greater than ~ 6172021 b T e
o 1246 1 o SMs CLOSED
1247 ) 28 Cancel | g SMs  CLOSED
1248 ¢ on roTroo I SMS CLOSED Interviewed 01/18
1249 4 do PUTPCG  1/22/21 No SMS CLOSED INterviewed 01/18
1250 do PUT PCG 1/22/21 No SMS CLOSED Interviewed 01/18
1251 do ROCKPCG  1/22/21 No CALL CLOSED Interviewed 01/21/21
1252 1 do PUT PCG 1/23/21 No SMS CLOSED Interviewed 01/16
[ 1253 do PUT PCG 1/23/21 No SMS CLOSED Interviewed 01/16 hd
“ »
;= - | - S ————
-
Ay File Home Insert Draw Data v Open in De Q Search V% @ 3 Econversation  ** | Close
?,? v 2l ﬁl ? ?( f;@ Text to Columns ~ {EH] Flash Fill ;! Remove Duplicates  £§ Data Validation v éHv o

H1512

1500 ROCK PCG  6/3/21 SMS CLOSED No Symptoms - Minor *
Calendar 1501 PUT PCG 6/5/21 George Fischer Middle ¢ SMS CLOSED Minor
1502 ROCKTVL  6/5/21 0 CLOSED Left voicemail
% 1503 PUT PCG 6/5/21 SMS CLOSED Agreed to SMS & Email
Sa% 1504 ROCK PCG  6/6/21 Eldorado Elementary Sc SMS CLOSED Minor (Spanish-speakin
1505 ROCKPCG ~ 6/6/21 SMS CLOSED Initial Interview Comple
50 1506 ROCKPCG ~ 6/6/21 INTERVIEW CLOSED "Registered in Error" Pa
1507 | . ROCK PCG  6/6/21 CALL CLOSED Invalid Phone Number r

REAPPLY ICON
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CLEANING UP CONTACT TRACER TAB

Contact LSt Templateisx — _

Q Your status message is showing in chat and channels when people message or @mention you. Change status, X
Acay File Home Insert Draw  Data ~ Open in Desktop App Q Search &~ I3 Elconversation | =+ Close
g:) [~ 4l il Y B} Remove Duplicates 5% DataValidation =~ 8H~ @H~
Chat ~
K5 v
i
Teams A B C D E F G H I J K
1 FirstName [ LastName | ContactiD |  primaryct [ Tempct | county | aED Follow-Up | Status Notes -
2 Darian Abreu ROCK TVL vaccinated & no symptoms
Calenciar 3 Darian Abreu - PUTPCG George Fischer Middle School Miner
4 Darian Abreu ROCK PCG Eldorado Elementary School Miner (Spanish-speaking)
5 Darian Abreu ROCK PCG Saint Anthony School
el 6 Darian Abreu ROCKTVL  6/26/21 SMS  CLOSED No symptoms; vaccinated
7 Darian Abreu ROCK TVL  6/26/21 SMS CLOSED No symptoms; vaccinated
) 8 Darian Abreu PUTPCG  6/26/21 SMS CLOSED Vaccine verified
9 Darian Abreu PUTTVL 6/28/21 SMS CLOSED 3x3x2 attempt made
10 Darian Abreu ROCKPCG  6/28/21 Viola Elementary School SMS CLOSED Minor (Spanish-speaking)
1 Darian Abreu PUTPCG  7/17/21 Surprise Lake Camp INTERVIEW OPEN Miner
12 Darian Abreu
13 Darian Abreu
B 14 Darian Abreu
e 15 , Darian Abreu , i
0 > = avreu [ i [ —r

WANT TO GET RID OF HIGHLIGHTED CONTACTS

Contact Bt Templatetex — —

Your status message is showing in chat and channels when people message or @mention you. Change status, X
Actvity File Home “ 1 Desktop App Q Search &7~ i1 Econversation | *+ | Close
@ Search
~ i =4 idati afv afw~
et r?j A cut E‘< Remove Duplicates &g Data Validation aH 2H o
K5 | A @™ Copy
Teams E F G H I J K
Paste Options. o Cluster Status Notes -
| 8 . ROCKTVL wvaccinated & no symptoms
D ﬁi ﬁ; | 8 - PUTPCG George Fischer Middle School Minor
| ' ROCK PCG Eldorado Elementary School Minor (Spanish-speaking)
% Insert > ROCK PCG Saint Anthony School

Calls

Delete > ROCKTVL ~ 6/26/21 SMS CLOSED No symptoms; vaccinated
ROCK TVL  6/26/21 SMS CLOSED No symptoms; vaccinated
PUTPCG  6/26/21 SMS CLOSED Vaccine verified
< 3 PUTTVL 6/28/21 SMS CLOSED 3x3x2 attempt made
10 ort ROCKPCG  6/28/21 Viola Elementary School SMS CLOSED Minor (Spanish-speaking)
11 #7 New Comment PUTPCG  7/17/21 Surprise Lake Camp INTERVIEW ~OPEN Minor
12
13 B2 Number Format... -
m 14 ~ N
aps | 15 Calibri v v AT A % Y -
‘ _ »
- P HeovAVERGEY [——————— ———
AFTER HIGHLIGHTING CONTACTS, CLEAR CONTENTS
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Contact Bt Templatextsx — _

Q Your status message is showing in chat and channels when people message or @mention you. Change status, X
Activity - Open in Desktop App Q Search VA 3 Econversation  ** | Close
g)[ Y P B r ' ra a Remove Duplicates .:“6 Data Validation 8fv éf~ »
a
Teams
2 ,
Calendar 3 l_ﬂﬁ I_?;lz fx v
4
Qg 5 Insert >
Calls 6
; Delete >
7
- 8 Clear Contents
9
10 Sort >
L = §J New Comment
12 eu
13 132 Number Format.. TEu
B 14 Mariam Ahras
B 5 v KA S %@ -
‘ _ »
T SpRRY - — -
@ = o —_—

HIGHLIGHT REMAINING CONTACTS, RIGHT CLICK AND SELECT CUT AND PASTE TO TOP

Q ‘Your status message is showing in chat and channels when people message or @mention you. Change status, X
b File Home  Insert ~ Draw  Data v Open in Desktop App Q@ search &~ 7 [Econversation | - Close
g v [Bow 8l %l Y 7 5 ZH texttocoumns &3 Flashfill [} Remove Duplicates 53 DataValidation =~ SH~ 2~
& D12 ¥ Jx Darian Abreu
Teams A A B (= D Ef F G H 1 J K
f a
2 Darian Abreu ROCKTVL  6/26/21 SMS CLOSED No symptoms; vaccinated
Calendar | 3 Darian Abreu ROCKTVL  6/26/21 SMS CLOSED No symptoms; vaccinated
4 Darian Abreu PUTPCG  6/26/21 SMS CLOSED Vaccine verified
% 5 Darian Abreu PUTTVL 6/28/21 SMs CLOSED 3x3x2 attempt made
e 6 Darian Abreu ROCKPCG  6/28/21 Viola Elementary School SMS  CLOSED Minor (Spanish-speaking)
7 Darian Abreu PUTPCG  7/17/21 Surprise Lake Camp INTERVIEW OPEN Minor
8
9
10
1
2| oatmn e ]
13 Darian Abreu
B 14 Darian Abreu
= 15 N Darian Abreu . -

@ > = [ Ve | _ - -+
FIND AND SELECT THE ENTIRE EMPTY ROW WITH A NAME IN IT
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Q
Y File Home  Insert  Draw  Data Open in Desktop App Q@ search ‘ &~ @ 7 Fconversation | Close
Q [P+~ [& workbooklinks = 4] %] Y % 52  GH texttocolumns &3 Flashril [} Remove Duplicates S5 DataValidation | 8Hv ZHv .
i A12 v fx v X
Teams 4 D | E | F | e | H | sﬁs—‘zﬁm‘ K | L M N o
2 Darian Abreu ROCK VL _ 6/26/21 No symptoms; vaccinated [«
3 Darian Abreu ROCKTVL  6/26/21 SMS CLOSED No symptoms; vaccinated
Calendar 4 Darian Abreu PUTPCG  6/26/21 SMS CLOSED Vaccine verified
5 Darian Abreu PUTTVL  6/28/21 SMS  CLOSED 3x3x2 attempt made
(X 6  Darian Abreu ROCKPCG ~ 6/28/21 Viola Elementary School SMS  CLOSED Minor (Spanish-speaking)
Calls 7 Darian Abreu PUTPCG  7/17/21 Surprise Lake Camp INTERVIEW OPEN Minor
8
e 9
10
1
13 Darian Abreu
14 Darian Abreu
15 Darian Abreu
m 16 Darian Abreu IL‘
biF (4] D
@ > = | e | —_ [ — —
HOVER OVER BOTTOM RIGHT CORNER OF CELL L UNTIL CROSSHAIR APPEARS

i i et o s s e o i st 1]

Activty File Home Insert Draw Data v Open in Desktop App Q Search &~ |._—1| E‘Conversation‘ | Close

g?t Py~ [® Workbook Links ‘ il AR Y ¢ 2 EE TexttoColumns (] Flash Fill B} Remove Duplicates % DataValidaton =~ @B~ @Hv

m L12 v k&
Teams A | D | E | RR;TVL'Lﬂfﬂﬂl H ] !IE_I'U@{ﬂl K | L | M N
2 Darian Abreu No symptoms; vaccinated [a
3 Darian Abreu ROCKTVL = 6/26/21 SMS CLOSED No symptoms; vaccinated
Calendar 4 Darian Abreu PUTPCG  6/26/21 SMS CLOSED Vaccine verified
5 Darian Abreu PUTTVL  6/28/21 SMS  CLOSED 3x3x2 attempt made
Q, 3 Darian Abreu ROCK PCG  6/28/21 Viola Elementary School SMS  CLOSED Minor (Spanish-speaking) |
Calls 7 Darian Abreu INTERVIEW _OPEN _Minor
8
aee 9
Darian Abreu
Darian Abreu
15 Darian Abreu
m 16 Darian Abreu -
o ] | N
— — — —
@ - - | - — — I -

C

-

ICK AND DRAG CROSSHAIR UP OR DOWN UNTIL ALL CELLS ARE FILLED WITH A NAME
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EDITING DATA VALIDATION (COUNTIES, FOLLOW UP & STATUS)

Contact tist Templateatsx — _

. Your status message is showing in chat and channels when people message or @mention you. Change status. X
BT File Home Insert Draw Page Layout Formulas Data Open in Desktop App Q search &~ 7 Hconversation - | Close
Q B~ [ 2l %l Y % 2 GH tettocolumns ] FlashFil [} Remove Duplicates % DataValidation =~ @8H~ @Hv "
at
con D1501 v &
[o))
Teams A B C D E F G H | J K

1500 1 Ao D14n4777-006 ROCK PCG  6/3/21 SMS CLOSED No Symptoms - Minor =
calendsr 1501 |, B Insert us024 | 1 PUTPCG  6/5/21 George Fischer MiddleS  SMS  CLOSED Minor
1502 5 ROCKTVL  6/5/21 0 CLOSED Left voicemail
S 1503 B Delete 348-025 PUT PCG 6/5/21 SMS CLOSED Agreed to SMS & Email
B 1504 Rename. 573-031 ROCK PCG  6/6/21 Eldorado Elementary Sc SMS CLOSED Minor (Spanish-speakin
1505 . 573-006 | ROCK PCG  6/6/21 SMS  CLOSED Initial Interview Comple
“t 1506 Reorder.. 573-021 | ROCK PCG  6/6/21 INTERVIEW CLOSED "Registered in Error” Pa
1507 . 573-031 L ROCKPCG  6/6/21 CALL CLOSED Invalid Phone Number r
1508 |, Duplicate 573034 ROCK PCG  6/6/21 INTERVIEW CLOSED Tranferred to CT Bonnie
1509 Tab Color > 573-007 ROCK PCG  6/6/21 SMS  CLOSED Agreed to SMS & Email
1510 573-030 ROCK PCG  6/6/21 0 CLOSED Invalid Phone Number -
1511 pdazabd Hide 573-025 ROCKPCG  6/6/21 No SMS OPEN  Will quarantine-Minor §
= BRLE - 573-002 ROCKPCG  6/6/21 No SMS OPEN  Will quarantine-Minor
o 1513} 071-004 L PUT PCG 6/7/21 0 CLOSED Transferred to Putnam i~
B% Show Changes — — — — :
® ’ - | _ _ _ —
i) Calculation Mode: Automatic  Workbook Statistics v — 100% +
ON MASTER TAB AND SELECT FROM MENU

: i — — _

Qo Your status message is showing in chat and channels when people message or @mention you. Change status. X
=iy File Home Insert Draw Page Layout Formulas Data v Open in Desktop App Q Search &~ i1 Econversation ' | Close
Chat v
vk
A B C D E E et H | J K
| FirstName - |Last Name - |Contact ID T IPAmaNET] Unhide B o ki s
1501 . SMS CLOSED Agreed to SMS & Email *
Select a sheet to unhide d =
1502 florado Elementary Sc SMS CLOSED Minor (Spanish-speakin
% 1503 | wst B SMS  CLOSED Initial Interview Comple
UNSORTED " . "
1504 INTERVIEW CLOSED "Registered in Error" Pa
I CTTEMPLATE (BACKUP)
“ 1505 c PR ! ! CALL  CLOSED Invalid Phone Number 1
1506 INTERVIEW CLOSED Tranferred to CT Bonnie
b 1507 SMS CLOSED Agreed to SMS & Email
1508 '| 0 CLOSED Invalid Phone Number -
1509 SMS OPEN  Will quarantine-Minor
1510 oK | Cancel SMS OPEN  Will guarantine-Minor
1511 | 0 CLOSED Transferred to Putnam i
1512 POTPCG /97T SMS CLOSED Agreed to QO, QR - Min
1513 i PUT PCG 6/9/21 SMS CLOSED Agreed to QO, QR - Min
o 1514 u ROCK TVL  6/10/21 SMS CLOSED vaccinated & no symptc =
v

o o = [ T T | - E—
LIST FROM MENU

24


daria
Rectangle

daria
Rectangle

daria
Rectangle

daria
Rectangle

daria
Rectangle

daria
Rectangle

daria
Rectangle


Contact Bt Template.xisx — _

[;»o Your status message is showing in chat and channels when people message or @mention you. Change status, X
Adtnity File Home Insert Draw Page Layout Formulas Data v Open in Desktop App Q Search Vg 0 Elconversation - | Close
@ e~ 2l il AT E' remove Duplicates £ DataValidation =~ 8H~ &@H~ .

Teams

A2 ¥ fx PUTNAM
| i

Calendar

&

Calls

Sl vosier WIS Abreu | —_ — —

=)
v
Il

COUNTIES, FOLLOW UPS OR STATUS AS NEEDED (JUST INPUT VALUE BEFORE ROW 15;
ROW 20 FOR COUNTIES)

Contact Hist Templatetsx — _

@o Your status message is showing in chat and channels when people message or @mention you. Change status. X
Aty File Home Insert Draw Page Layout Formulas Data Open in Desktop App Q search &~ o=} = conversation Close
c[? (3% 8l %l Y ZH Texttocolumns  {H Flash il [} Remove Duplicates 5% DataValidation =~ @H~ &+
nat v
ses  G10 v
w
Teams A B (e o} E F G H | J K L M N o
1 County Fallow Up Status -
2 PUTNAM - OPEN
Clender | 3 ER insert CLOSED
4 ROCKLAND
% 5 EZ Delete
=S 6 ORANGE Rename.
7 ULSTER
8 DUTCHESS Reorder...
) SULLIVAN Duplicate
10 | wesTcHEsTER L1
" Tab Color 2
12
13 Hide
S 14 Unhide. b Snip & Sketch
Apps 12 . .
1 R show Changes Snip saved to clipboard
0) b /1 tor O —

ON LIST TAB AND HIDE
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